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Cos'è Full Circle

Full Circle è una rivista gratuita e

indipendente, dedicata alla

famiglia Ubuntu dei sistemi

operativi Linux. Ogni mese

pubblica utili articoli tecnici e

articoli inviati dai lettori.

Full Circle ha anche un podcast di

supporto, il Full Circle Podcast,

con gli stessi argomenti della

rivista e altre interessanti notizie.

Si prega di notare che questa
edizione speciale viene fornita
senza alcuna garanzia: né chi ha
contribuito né la rivista Full Circle
hanno alcuna responsabilità circa
perdite di dati o danni che
possano derivare ai computer o
alle apparecchiature dei lettori
dall'applicazione di quanto
pubblicato.

Come contattarci

Sito web:
http://www.fullcirclemagazine.org/

Forum:
http://ubuntuforums.org/forumdisp
lay.php?f=270

IRC:#fullcirclemagazine su
chat.freenode.net

Gruppo editoriale

Capo redattore: Ronnie Tucker
(aka: RonnieTucker)
ronnie@fullcirclemagazine.org

Webmaster: Rob Kerfia
(aka: admin / linuxgeekery-
admin@fullcirclemagazine.org

Editing e correzione bozze
Mike Kennedy, David Haas,
Gord Campbell, Robert Orsino

I nostri ringraziamenti a Canonical e
ai vari gruppi di traduzione nel
mondo

Inizia la serie su Blender...

In questo volume iniziamo ad assemblare la serie di Nicholas
Kapakakis su Blender.

Quella che avete davanti è la ristampa della serie Blender,
parti 1 -10, pubblicata dal numero 68 al numero 82.

Vi chiediamo, però, di badare alla data di pubblicazione: le
versioni attuali di hardware e software potrebbero essere
diverse rispetto ad allora. Controllate il vostro hardware e il
vostro software prima di provare quanto descritto nelle guide
di queste edizioni speciali. Potreste avere versioni più recenti
del software installato o disponibile nei repository delle vostre
distribuzioni.

Buon divertimento!

Gli articoli contenuti in questa rivista sono stati rilasciati sotto la licenza Creative Commons Attribuzione - Non commerciale - Condividi allo stesso modo 3.0.
Ciò significa che potete adattare, copiare, distribuire e inviare gli articoli ma solo sotto le seguenti condizioni: dovete attribuire il lavoro all'autore originale in
una qualche forma (almeno un nome, un'email o un indirizzo Internet) e a questa rivista col suo nome ("Full Circle Magazine") e con suo indirizzo Internet
www.fullcirclemagazine.org (ma non attribuire il/gli articolo/i in alcun modo che lasci intendere che gli autori e la rivista abbiano esplicitamente autorizzato voi

o l'uso che fate dell'opera). Se alterate, trasformate o create un'opera su questo lavoro dovete distribuire il lavoro risultante con la stessa licenza o una simile o compatibile.
Full Circle magazine è completamente indipendente da Canonical, lo sponsor dei progetti di Ubuntu, e i punti di vista e le opinioni espresse nella rivista non sono in alcun modo da attribuire
o approvati da Canonical.

Full Circle
LA RIVISTA INDIPENDENTE PER LA COMUNITÀ LINUX UBUNTU

http://www.fullcirclemagazine.org
http://ubuntuforums.org/forumdisplay.php?f=270
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È
piuttosto bislacco iniziare un
articolo con un linkperYoutube,
ma penso che se vi piacerà ciò che
visualizzerete, amerete anche

tutti i rimanenti tutorial come questo.

Sentitevi liberi di seguire il
collegamento qui sotto e di tornare qui
tra circa 1 5 minuti, ripetendo la
procedura per il numero delle volte che vi
aggrada:
http://www.youtube.com/watch?v=eRsG
yueVLvQ

Sintel (www.sintel.org) non è la
ragione per la quale ho cominciato a
pasticciare con Blender, ma ritengo che
se non l'avessi fatto fino a quel
momento, avrei certamente “intrapreso il
mio viaggio” subito dopo.

Quindi, parliamo di Blender
(www.blender.org), il programma che è
dietro Sintel emolte animazioni simili (di
fatto Blenderè dietromolte questioni
che riguardano il 3D). Blenderè
disponibile perLinux, Windows, MacOSX
e FreeBSD (sia per sistemi 32-bit che per
64-bit).

Quando è stato scritto questo
articolo la più recente versione era la

2.64, ma noi lavoreremo con la 2.62 che
potrete trovare nei repository di Ubuntu.
Se non l'avete ancora installata,
procedete e installatela dal repository.

In questi tutorial useremo un mouse a
3 tasti e una tastiera con tastierino
numerico. Blenderpresume che li abbiate
entrambi. Ma, se non fosse così, potete
cambiare tali impostazioni andando in
File>UserPreferences. Selezionate la
scheda Input e, sulla sinistra, mettete la
spunta su Emulate 3 Button Mouse e
Emulate Numpad.

Vi troverete innanzi ad una schermata
di caricamento chemostra nell'angolo in
alto a destra la versione di Blendere
alcuni link. Perora ignorateli e premete
qualsiasi pulsante delmouse in un punto
fuori da tale area.

Se siete nuovi ai programmi di
animazione 3D, non disperate.
Concedetegli un po' di tempo e ci farete
l'abitudine: provare, sperimentare e
provare ancora sono i soli tremodi per
eccellere in Blender. Se avete
dimestichezza con programmi similari
(Maya, 3DS, Max, ecc), troverete qualcosa

di diversoma la filosofia principale
rimane la stessa.

Quindi, siamo in Blendere vediamo
l'editor 3D view, qualche pulsante sulla
sinistra, qualche pulsante e dei numeri
sulla destra e una linea temporale in
basso. Lavorare in Blender significa
soprattutto “lavorare sul 3D view
modifier”.

Lavorare con Blender implica
modellare, animare, illuminare,
comporre, dare texture (useremo tutti i
modificatori), ma il 3D viewmodifier (o
finestra della Vista 3D) è il posto dove
viene sempre visualizzata ogni modifica.

L'editorVista 3D è la grande finestra
al centro del nostro schermo. Potete
osservare al suo interno un cubo, una
videocamera e una luce.

Premete F1 2.

Cosa succede?Beh, avete già
renderizzato la vostra prima scena su
Blender!

SUGGERIMENTO: Potete ispezionare
le immagini renderizzate in precedenza
premendo in qualunquemomento F1 1 .

http://www.youtube.com/watch?v=eRsGyueVLvQ
http://www.sintel.org
http://www.blender.org
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Premendolo ancora tornerete all'editor
della vista 3D.

Muovete ilmouse sull'immagine e
premete Esco F1 1 peruscire dalla
finestra con l'immagine renderizzata e
tornare al 3D ViewModifier.

Ciò di cui necessitate per avere una
scena completa è un dispositivo di ripresa
(la videocamera), un soggetto da
immortalare (il cubo) e alcune luci.

Ora focalizziamo la nostra attenzione
sulla barra sotto la finestra Vista 3D,
chiamata Header (e illustrata in basso).

Notiamo la piccola
scatolina (qui a fianco) che si
trova dalla parte sinistra. È il

selettore del tipo di modificatore.

Fare clic con il TSM (Tasto Sinistro del
Mouse) sulla piccola scatolina 3D per
cambiarne la modalità d'azione.

Dalla lista, selezionate Python
Console (la prima voce in alto).

Hey! Dov'è finita la mia scatola?

Non abbiate paura, il vostro cubo è
sempre là dove lo avete lasciato. Dallo

stessomenu selezionate 3D View. Voilà!
La vostra scatola è lì. Vedete?

In Blender, potete cambiare ogni
finestra in ogni tipo di modificatore che
volete. Sarà una caratteristica molto utile
in futuro, quando vorremo essere più
produttivi. Andate avanti e trovate le
altre quattro intestazioni di finestra sul
vostro schermo (ce ne sono cinque in
tutto).

Notate che ogni finestra ha diverse
intestazioni con diverse opzioni, e ogni
volta che cambierete ilmodificatore,
l'intestazione cambierà di pari passo.

Adesso cambiate ogni modificatore in

info (l'intestazione in alto nello schermo è
già su info, quindi non dovrete cambiarla).

In qualunquemomento, premete
File>Newnell'intestazione info per
ricaricare le impostazioni predefinite.

OK. Iniziamo un nuovo progetto.
Premete File>Newnell'intestazione info.

Tutto è tornato al proprio posto.

Muovete ilmouse nella finestra
dell'editordi vista 3D e premete il TCM
(Tasto Centrale delMouse) mentre
spostate il cursore alla rinfusa. State
ruotando la vista. Muovendo la rotellina
delmouse in su e in giù invece farete

degli zoom in avvicinamento o
allontanamento.

Alt+Shift+Rotellina delMouse si usa
per ruotare la vista su e giù.

Alt+Control+Rotellina delMouse
ruota la vista a destra e a sinistra.

Potete anche fare una panoramica
(pan) della vista. Shift+TCM si usa per
effettuare il pan, Shift+Rotellina del
mouse per andare su e giù o
Control+Rotellina delmouse per andare
a destra e sinistra.

Potete ingrandire o rimpicciolire
anche senza usare la rotellina delmouse.
Usate Control+TCM, muovendo in alto
(per ingrandire) o in basso (per
rimpicciolire).

È abbastanza peroggi con le rotazioni
e il pan. Vediamo come selezionare!

Iniziate un nuovo progetto: File>New.
Come predefinito quando cominciate un
nuovo progetto, il cubo è selezionato
(l'indicatore di cosa è selezionato sono gli
spigoli del cubo illuminati d'arancione).

Adesso premete il tasto A.
Deselezionerete il cubo (e nulla sarà più
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Nicholas Nicholas vive e lavora in
Grecia. Lavora per una casa di post-
produzione (pubblicità-film) da
diversi anni. Tre mesi fa è migrato su
Ubuntu perché “renderizza più
velocemente”. Blender ha trovato lui
due anni fa.

HOWTO - BLENDER Parte 1
illuminato nella scena).

Premendo Adi nuovo, selezionerete
tutti gli oggetti nella schermata: il cubo, la
videocamera e le luci. Premete ancora A
perdeselezionare ogni cosa.

Ora premete il TDM (Tasto Destro del
Mouse) sul cubo. Avete selezionato il
cubo e ora è in evidenza.

Clic con il TDM sulla luce. Avete ora
selezionato la luce e contemporaneamente
deselezionato il cubo.

Premete Aper rimuovere dalla
selezione la luce.

Selezione con Shift

Premete il TDM sulla luce e quindi
premete Shift+TDM sul cubo. Avete
selezionato la luce E il cubo (notate i
bordi della luce che danno più sul rosso).

Adesso premete Shift+TDM sulla
videocamera (notate ancora gli spigoli
rossi). Questa è la selezione d'insieme,
ossia avete aggiunto la videocamera alla
selezione precedente.

Usate la combinazione Shift+TDM sul
cubo.

I bordi rossicci diventano arancioni.

Shift+TDM ancora sul cubo per
deselezionarlo. Adesso avrete in
selezione la videocamera e la luce.
Premete Aperdeselezionare ogni
oggetto.

Adesso, usando il TCM, ruotate la
vista, in modo da vedere tutti e tre gli
oggetti, e deselezionateli tutti con il tasto
A (potreste anche caricare una scena
tutta nuova selezionando File>Newo
Control+N, e sul nuovo progetto
premere Aperdeselezionare il cubo).

Strumento di selezione
Riquadro

Prendendo per certo il fatto che
abbiate caricato un nuovo progetto o che
abbiate una vista similare, muovete il
mouse sopra a destra della luce e
premete il tasto B. Compare una croce.
Adesso tenete premuto il TSM e
trascinate ilmouse in basso a sinistra in
modo che il Riquadro selezioni tutti e tre
gli oggetti.

Mitico! È tutto selezionato in un
modo differente e più rapido rispetto alla
selezione con Shift+TDM. Premete Adi
nuovo per annullare la selezione.

Strumento di selezione
Cerchio

Premete Ce apparirà un cerchio.

La selezione Cerchio lavora in modo
cumulativo, come avviene premendo il
tasto Shift per selezionare, quindi fare clic
col TSM sul cubo aggiungerà il cubo alla
selezione.

Muovendo la rotellina delmouse su e
giù, potrete aggiustare il raggio del
cerchio rendendo la selezione più precisa
o più generica.

Ricordate, ogni volta che premete il
TSM aggiungete l'oggetto alla selezione
corrente.

Premete il TCM per rimuovere
oggetti dalla selezione.

Premete ESCperuscire dalla
modalità selezione.

Strumento di selezione
Lazo

Premete e tenete premuti
Control+TSM e trascinate ilmouse per
fissare dei bordi attorno ad un oggetto.
Potete selezionare più oggetti in maniera
più accurata rispetto allo strumento di
selezione Riquadro.

Potete aggiungere oggetti alla

selezione con la combinazione
Control+TSM, e potete sottrarre degli
oggetti dalla selezione con l'aggiunta del
tasto Shift alla combinazione:
Control+Shift+TSM. Tenete premuto
Control+Shift+TSM e sottraete degli
oggetti dalla selezione.

Andate su File>Newo premete
Control+N. Avviate un nuovo progetto.

Fate pratica, esperimenti e PRATICA!
Ruotate le viste, pan sulla schermata,
ingrandimenti, rimpicciolimenti, selezioni
multiple e deselezioni.

Il prossimomese, creeremo davvero
qualcosa.

Andate su
http://www.youtube.com/watch?feature
=player_embedded&v=R6MlUcmOul8

Godetevi “Tears ofSteel”
(www.tearsofsteel.org) della Blender
Foundation.

http://www.youtube.com/watch?feature=player_embedded&v=R6MlUcmOul8
http://www.tearsofsteel.org
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C ome promesso lo scorsomese, oggi
inizieremo a creare qualcosa. Ma

prima di tutto, distruggiamo il cubo!

Iniziate un nuovo progetto in
Blender: File -> New, o aprite
semplicemente Blender.

Premete l'1 del tastierino numerico
per avere una vista frontale. Nell'angolo
in alto a sinistra potete accertarvi di cosa
state visualizzando.

Adesso premete il tasto 5, sempre
del tastierino. Potete così cambiare la
vista da “Prospettiva” a “Ortogonale”.
Premendo il tasto 5 infatti si passa dalla
vista in prospettiva a quella ortogonale
e viceversa.

Suggerimento: La modalità Prospettiva
è la stessa di come i nostri occhi vedono
ilmondo. Gli oggetti più vicini sembrano
più grandi di quelli distanti.

Con la vista Ortogonale, d'altra
parte, è come guardare un oggetto da
una distanza infinita. Tutti gli oggetti
sembrano essere alla stessa distanza
rispetto agli occhi. La proiezione
Ortogonale è uno dei modi per
rappresentare un oggetto

tridimensionale in due dimensioni
(http://it.wikipedia.org/wiki/Proiezione_
ortogonale), molto utile per la
modellazione!

Nell'immagine in basso a sinistra
abbiamo quindi una vista ortogonale. Il
nostro cervello non può capire quale
lato sia quello frontale. Ma èmolto utile
per crearemodelli, dato che di fatto a
noi non interessa propriamente la
prospettiva, quanto le dimensioni
effettive del nostromodello. La
prospettiva sarà molto più realistica se
creeremomodelli senza tener conto di
essa!

Nell'immagine in basso a destra,
vediamo il cubo in maniera prospettica;
in questomodo il nostro cervello

comprende qual è il lato più vicino,
sapendo che si tratta di un cubo.

Ovviamente questa è una mia
opinione. Può darsi pure che voi riusciate
a modellaremeglio e più rapidamente
usando la vista in prospettiva. Tutto
dipende dalle vostre capacità.

Pochi mesi addietro, Markha
cominciato a spiegare il grande
programma Inkscape (in futuro
vedremo come combinare Inkscape con
Blender) creando un pupazzo di neve. Mi
èmolto piaciuto quell'esempio, quindi
anche noi creeremo un pupazzo di neve.
Ma prima, distruggiamo il cubo!

Selezionate il cubo con il TDM e
premete il tasto Xo Canc, confermando

poi l'eliminazione con il tasto Invio.

Adesso premete Shift+Aper
aggiungere qualcosa e dalmenu
selezionateMesh -> UVSphere o
dall'intestazione premete Add ->Mesh
-> UVSphere per aggiungere un nuovo
reticolo alla scena. Ecco che appare una
sfera.

Immagino che vi troviate in una vista
ortogonale-frontale (guardate
nell'angolo in alto a sinistra della vostra
finestra di vista 3D), con la sfera
selezionata. Se non fosse così, premete
1 dal tastierino numerico.

Premete Shift+Aper aggiungere un
nuovo reticolo, di nuovo una sfera UV.
Non vedrete nessuna differenza sul
vostro schermo. Niente paura, TSM e
trascinate la freccetta blu che punta
verso l'alto, permuovere la sfera lungo
l'asse delle Z. Piazzatela vicino alla
sommità della sfera che è rimasta fissa.

Premete il tasto S per scalare la sfera
muovendo ilmouse verso il centro del
cursore. Traslate ancora un po' la sfera
verso il basso in modo che un pezzettino
sia “nella” sfera più grande.

http://en.wikipedia.org/wiki/Orthographic_projection
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Adesso premete Shift+D per

duplicare la sfera selezionata. Premete Z
perbloccarne ilmovimento alla sola
asse Z, poi premete e tenete premuto il
TSM permuoverla vicino alla sommità
della seconda sfera.

Premete S e scalate la terza sfera.

È già qualcosa.

Premete File -> Save As per salvare il
vostro lavoro. Selezionate dove volete
salvare il file, dategli un nome univoco
(pupazzodineve.blend, ad esempio) e
premete il pulsante Save As BlenderFile
nell'angolo in alto a destra. Fantastico!

Ora, selezionate la prima sfera
premendoci sopra con il TDM. Premete
S e quindi Z per scalare la sfera solo
relativamente all'asse Z.

Fate lo stesso per le altre due sfere
in modo da renderle più “realistiche”
(comemostrato al centro, a sinistra). La
gravità schiaccia le palle di neve verso
terra.

Premete N per aprire o chiudere il
Transform Properties shelf sulla destra
della vista 3D. Da qui, potrete visionare e
modificare le proprietà del vostro
oggetto numericamente (come
mostrato al centro, sulla destra).

Nella vista ortogonale frontale,
premete TSM in qualunque punto a
destra del corpo del pupazzo di neve.
Premete Shift+Aper aggiungereMesh
-> Cone. Premete Rper ruotarlo, e 90
per indicare l'angolo di rotazione.

Suggerimento: Potete inserire
manualmente dei valori semplicemente
digitandone il valore. Potete anche
usare valori negativi per ruotare gli
oggetti in senso antiorario.

Premete il 3 del tastierino numerico
per avere la vista da destra. Premete S
per scalare e Shift+Xpervincolare la
dimensione lungo l'asse delle Xe
modificare in contemporanea quelle su

Ye Z. Scalate il cono in modo da dargli
una dimensione simile ad una carota,
relativamente alla terza sfera creata (la
testa del pupazzo).

OK, ora premete 1 per la vista
frontale, quindi S e Xper apportare
modifiche solo relativamente all'asse X.
Ora create un naso a carota lungo o
corto.

Premete Re -1 0 per ruotare il naso di
1 0° in senso antiorario.

Usando la vista frontale e quella da
destra, piazzate il naso da qualche parte
al centro della testa del pupazzo.

Ora creiamo qualche bottone.
Premete Shift+Aper aggiungereMesh
-> Cylinder. Usate lo stesso strumento
usato permodellare il naso-carota per
creare un bottone delle dimensioni di
una moneta. Scalatelo, ruotatelo, usate
la vostra immaginazione! Non
dimenticate poi di duplicarlo con Shift+D
peressere più produttivi.

Quando sarete soddisfatti del vostro
modello, salvate il vostro lavoro.

Premete F1 2 per farne un rendering.

Il pupazzo di neve sembrerà un
tantino ridicolo. La neve non ha quei
bordi, sembrano più dei cristalli ben
realizzati! Dobbiamo smussarli un po'.

Quindi, premete il tasto Tper aprire
il Tool Shelfe gli strumenti adatti sulla
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sinistra. Sotto la sezione Shading, avete
due opzioni: Smooth e Flat. Con una
sfera selezionata (o anche tutte)
premete il tasto Smooth. Il vostro
pupazzo di neve sarà ora più liscio!

Potete osservare la differenza.
Nell'immagine al centro sulla destra, le
sfere sono livellate come se fossero dei
cristalli, mentre in quella sulla sinistra
abbiamo applicato lo Smooth che
conferisce levigatezza e naturalità alla
neve.

Usando lo strumento di selezione
Riquadro che abbiamo visto ilmese
scorso, selezionate tutti gli oggetti che,
uniti, rappresentano il “pupazzo di
neve”. Le sfere, i cilindri e il cono.

Usando la freccia blu, muovete il
pupazzo di neve verso l'alto come
mostrato nelle immagini qui sopra,
giusto un pelino sotto l'asse rosso.

Premete Shift+S. Dalmenu Snap
apparso, selezionate Cursor to Center.
Premete il tasto 7 del tastierino
numerico per la vista dall'alto. Premete
Shift+Aper aggiungere un nuovo
elemento. Un Plane (un piano). Premete
S per scalare il piano e 1 0 per scalarlo di
1 0 volte.

Abbiamo un terreno.

Salvate il vostro lavoro con un nome
univoco.

Renderizzate il pupazzo di neve
premendo F1 2.

Se la vostra videocamera non
riprende ilmodello come desiderate voi,
spostatela.

Ogni mese, vi suggerirò un sito
interessante perBlender. Perquesto
mese, vi consiglio caldamente
http://www.Blendernation.com, un sito
molto utile con notizie fresche riguardo
Blender.

E anche perquesto numero ho un
video pervoi. Andate su
http://www.youtube.com/watch?v=TLk
A0RELQ1g, e gustatevi “Elephant
Dreams”, un corto d'animazione creato
con Blendernel 2006 dall'Orange Open
Movie Project.

Il prossimomese, aggiungeremo un
cappello, una pipa probabilmente e delle
mani simili a scopette. Inoltre, vi
introdurrò l'EditMode (la modalità
modifica), il luogo in cui andrete a
spendere la maggiorparte del vostro
tempo in Blender!

http://www.Blendernation.com
http://www.youtube.com/watch?v=TLkA0RELQ1g
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P ertante, tantissime volte nelle
sessioni di Blenderpremerete il

tasto TAB. È il tasto rapido perpassare
alla modalità Edit.

Caricate il file pupazzodineve.blend
che avevamo creato lo scorsomese e
visualizzate sulla barra di intestazione il
pulsante chemostra che siete in Object
Mode (è chiamata intestazionema è
posizionata, comepredefinito, dove
dovrebbe esserci il pie' di pagina).

Selezionate con il TDM la testa del
nostro pupazzo di neve (la sfera UV in
cima).

Premete il tasto TAB. Tutta la barra
d'intestazione cambierà e ora leggerete
“EditMode” sullo stesso pulsante di
prima (in alternativa, potreste premere
quelpulsante e da lì selezionare Edit
Mode. Perora, non abbiamobisogno di
sapere in cosa consistono le altre
modalità).

Anche la sfera UVsi trasforma in una
sfera reticolata arancione.

Siete in modalità Edit. In questo
contesto sarete in grado di aggiustare e
manipolare solo gli oggetti selezionati.
Peresempio, provate a selezionare la
luce o il naso con il TDM. Non potrete. È
selezionabile solo un vertice o un
gruppo di vertici dell'oggetto che si sta
modificando. Il vertice è una coordinata
tridimensionale, lo spigolo è una linea
che connette due vertici e la faccia è lo
spazio piano racchiuso fra tre o più
vertici.

In modalità Edit, potete selezionare
vertici, spigoli e facce nello stessomodo
visto nella prima parte di questa serie, 2
mesi addietro. Usate lo strumento di
selezione Riquadro, il lazo, lo strumento
di selezione circolare, TDM e Shift+TDM
perselezionare più vertici.

Anche nella
barra di
intestazione,

osservate i tre piccoli pulsanti che
rappresentano la selezione di vertici,
spigoli e facce. Da questi pulsanti potete
impostare cosa desiderate selezionare
(vertici, spigoli o facce). In alternativa,
premete sulla tastiera la combinazione

rapida Ctrl-Tab.

Andiamo avanti, tornando alla
modalità Objectpremendo il tasto TAB.

Sulla barra di intestazione potrete
notare ancora una volta che i pulsanti
menzionati prima sono scomparsi e
sono tornati alcuni vecchi tasti.
Focalizziamoperunminuto l'attenzione
sui pulsanti illustrati sotto.

Sono chiamati LayersButtons. Il
punto giallo nelpulsante in alto a sinistra
indica che abbiamo degli oggetti in quel
layerche erano stati selezionati o che lo
sono stati di recente e il colore grigio
scuro indica che ci troviamo
correntemente in quel layer.

Premete il numero 2 sulla vostra
tastiera (NON sul tastierino numerico),
oppure il secondo pulsante a partire
dall'angolo in alto a sinistra. Tutto
scompare, dato che ci troviamoora in un
layerdifferente. Premete Shift+Sper il
menu Snap e selezionate Cursorto
Center. Premete Shift+Aperaggiungere
un nuovo oggetto. Dal relativo gruppo
Mesh selezionate Cylinder. Guardate

adesso i pulsanti Layer.

Ci vienemostrato che abbiamo
oggetti in due layere il secondo di essi è
anche il layerattivo con qualcosa di
selezionato all'interno. Premete Sper
scalare e digitate 0.3 perrimpicciolirlo
del 30%. Premete G pertrascinare, Z per
vincolarlo all'asse delle Z e 0.3 per
muovere il vostro cilindro in alto del 30%
rispetto ad un'unità di Blender.

Se non è già selezionato, premete il 5
del tastierino numerico percambiare la
vista in Ortogonale (spiegazione in FCM
#69) e il 7 del tastierino numerico per
avere la vista dall'alto.

Premete il tasto TABperentrare
nella modalità Edit. Qualora aveste
spostato il cursore, premete Shift+Se
Cursorto Centerpermuovere il cursore
nuovamente nel centro della griglia.
Premete Shift+Aperaggiungere un
Circle, dalmenuMesh. Dopo di ciò,
premete F6 e, dalla finestra che si aprirà,
modificate il Fill Type da Nothing a
Ngon. Successivamente, premete Sper
scalare, 0.5 perrimpicciolire il cerchio del
50%.
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Premete il tasto TABperritornare
alla modalità Object. Mentre siete in
modalità Edit, gli oggetti che
aggiungerete (come in questo caso il
cerchio) saranno considerati parti di un
oggetto solo e Blender li manipolerà
come singoli oggetti.

Abbiamo il cappello. Adesso creiamo
lemani del nostro pupazzo di neve.
Premete 3 sulla tastiera (NON sul
tastierino numerico) per lavorare nel
Layer3.

Ancora Shift+Spermuovere il nostro
puntatore al centro. Shift+Aper
aggiungere una nuovaMesh, ossia un
nuovo cilindro. Premete Sperscalare,
Shift+Zpermantenere le dimensioni
dell'asse Ze alterarle sugli altri due assi,
Xe Y. Premete 0.02 perscalare del 2%.
Dopo questo, premete Snuovamente, Z
peralterare solo le dimensioni dell'asse
Ze 0.5 perdimezzarne la lunghezza.
Torniamo ancora alla modalità Edit. Con
il cilindro selezionato, premete TAB.
Aggiungete un nuovo cilindro, scalatelo,
ruotatelo emuovetelo in modo da

creare un braccio ramificato.

Quando avrete creato il vostro
rametto, premeteAlt+1 sulla tastiera
(NON su tastierino numerico) per
selezionare il Layer 1 1 .

SUGGERIMENTO: Premendo 1 ,2,3...
fino a 0 sulla tastiera, selezionerete un
layerattivo da 1 a 10. Questo sarà nella
fila superiore delpulsante Layer
menzionato prima. PremendoAlt+1 ,
Alt+2... fino ad Alt+0 selezionerete la riga
dei layerche vanno dall'1 1 al 20.

Con il Layer 1 1 attivo, aggiungete un
nuovo cilindro (a questo punto dovreste
già sapere come aggiungere una nuova
Mesh).

Premete il tasto TABperpassare alla
modalità Edit. Premete il tasto Zper
visualizzare il vostro cilindro come
reticolato. Questa vista del vostro
oggetto èmolto utile e personalmente
sono solito passare spesso dalla vista
solida a quella di tipo reticolato.
PremeteAperselezionare tutti i vertici
(se non sono già selezionati; quando si è
in modalità Object, premendoAsi
selezionano tutti gli oggetti mentre in
modalità Edit lo stesso tasto seleziona o
deseleziona tutti i vertici).

È giunto ilmomento di creare una
pipa.

Assumendo che vi
troviate in una vista
frontale ortogonale, il

pulsante piccolo sulla destra del
pulsante relativo alla modalità
selezionata indica il simbolo della vista a
reticolo...

Selezionate tutti i vertici.

Scalate il vostro cilindro
rimpicciolendolo dell'8%.

Premete il tastoAperdeselezionare
tutti i vertici. Ora, selezionate tramite
riquadro (usando il tasto B) solo i vertici
superiori.

Scalate per ingrandire un pochino,
premendo il tasto Semuovendo il
mouse lontano dal centro della
selezione. PremeteAperdeselezionare
tutti i vertici e selezionate con lo

strumento riquadro soltanto i vertici in
basso.

Scalate premendo Se rimpicciolite
un po' muovendo il vostromouse verso
il centro della selezione. Dopo ciò,
aggiungete un nuovo cilindro,
rimpicciolitelo, e create il resto della
vostra pipa.

È ilmomento buono persostituire il
naso che abbiamo creato ilmese scorso
(usando un cono) con uno nuovo basato
su un cilindro, dato che effettivamente
non vogliamo dei contorni così affilati
per il nostro naso-carota.

Fate esattamente tutto ciò che
abbiamo fatto con il cilindro poco fa per
creare un altro braccio a rametto.
Piazzatelo su un nuovo layero nel layer
dove già avete l'altro braccio. Potreste
anche duplicare il braccio-rametto già
creato selezionandolo e premendo
Shift+D.

Ora che avete tutti gli elementi nei
vari layer, potete anchemuovere tutti gli
oggetti verso il layerdi partenza (Layer
1 ), oppure premere Shifte il pulsante del
relativo Layerche contiene degli oggetti
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velocemente”. Blender ha trovato lui
due anni fa.
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percombinare la vista di tutti i layerche
sono selezionati.

SUGGERIMENTO: Permuovere un
oggetto verso un altro layer, selezionate
l'oggetto e premete il tastoM. Dalla
finestra Move to Layer, selezionate dove
volete spostare il vostro oggetto.

Il prossimomese, aggiungeremo
qualche colore alle nostre creazioni,
introducendo le texture!

Perquestomese, vi suggerisco
http://www.blenderartists.org, un
forum dove trovare le ultime notizie,
annunci di lavoro, opere e tutto ciò che
riguarda Blender.

Inoltre, anche questomese ho un

video pervoi. Andate su
http://www.youtube.com/watch?v=USy
oT_Ha_bA, e guardate nel 1 963
l'antenato di tutta la computergrafica, lo
Sketchpad di Ivan Sutherland (la mia
tavoletta graficaWacom sta ancora
piangendo).

CCOODDEEWWOORRDD

Le soluzioni sono sulla terz'ultima pagina.

Ogni numero nella griglia è il "codice" di una lettere dell'alfabeto.
Quindi il numero "2" può corrispondere alla lettera "L", per
esempio. Tutti, eccetto i codeword difficili , hanno alcune lettere
per iniziare.

I giochi sono copyright, e gentilmente forniti
da, The Puzzle Club - www.thepuzzleclub.com

http://www.blenderartists.org
http://www.youtube.com/watch?v=USyoT_Ha_bA
http://www.thepuzzleclub.com
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L e texture e i materiali sono un
punto cruciale. Senza di essi, ad

esempio, ciò che abbiamo creato
fin'ora è solo un pupazzo di neve
grigio, con un naso grigio, mani grigie
e un cappello, anch'esso grigio. Non è
poi così realistico. Per cui, i materiali e
le texture sono i modi usati per
conferire realismo all'aspetto del
nostro modello, attraverso immagini,
semplici colori, ecc...

Dovete avere un materiale per
potervi applicare sopra una texture (in
automatico blender aggiunge un
materiale agli oggetti per poterne
visualizzare le superfici).

Pertanto per questo mese
introdurremo i materiali, tenendo da
parte le texture per il mese prossimo,
dato che è impossibile trattarli
entrambi in un unico articolo.

Ma, prima di tutto, aggiorniamo
Blender. È disponibile un nuovo
rilascio (2.66a) su
http://www.blender.org/download/ge
t-blender/ con tante novità e oltre 250
bug corretti.

Carichiamo il file relativo al

pupazzo di neve creato lo scorso
mese. Dovrebbe assomigliare a questo
in modalità oggetto (illustrazione in
basso):

Notate le piccole icone a destra
della finestra Vista 3D. La quarta icona
da destra (evidenziata) è relativa alla
scheda Materiali.

Selezionate il cappello e premete il
pulsante New:

Chiamate il nuovo materiale
“Cappello”. La scheda materiali
dovrebbe quindi assomigliare a quella
sulla destra:

Come potete vedere, ci sono tante
cose che potremmo manipolare, ma
qui introdurremo solo quelle basilari
per ottenere un qualche tipo di
ambiente realistico (possibilmente,
nell'ultima parte di questa serie di
articoli, potremo focalizzare
l'attenzione su materiali e texture
spiegandoli in dettaglio ma, per ora,
sentitevi liberi di sperimentarli da soli).

http://www.blender.org/download/get-blender/
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Blender fornisce una finestra
d'anteprima, dove ispezionare il colore
del nostro materiale. Inoltre, sulla
destra, possiamo cambiare l'oggetto
nell'anteprima (non va bene per tutti i
nostri oggetti, ma aiuta a capire la resa
del colore, ad esempio su sfere o
scatole).

Sotto Diffuse, vi è una riga bianca.
Premete con il TSM (Tasto Sinistro del
Mouse) su di essa per cambiarne il
colore. Selezionate il colore che
desiderate dalla ruota dei colori, o
inserite manualmente i valori di Rosso,
Verde e Blu sotto la ruota, o ancora
usate il contagocce, strumento ben
noto di tutte le applicazioni di grafica.

Potete usare il pulsante HSV per
selezionare il colore da Hue Saturation
and Value, oppure potete usare i
numeri esadecimali comunemente
usati per specificare i colori delle
pagine web. Io personalmente uso i
colori RGB. I loro valori variano da 0 a
1 , indicando la percentuale di colore
(0.2=20%, ad esempio).

Sulla destra della ruota c'è un
cursore che controlla l'intensità del
colore. Se lo spingete tutto in basso, si
otterrà il nero assoluto. Notate inoltre
che così facendo i valori di Rosso,
Verde e Blu passano a 0.

Anche sotto Specular vi è una
striscia bianca. Da questa possiamo
scegliere il colore dei riflessi sugli
oggetti riflettenti. Per esempio
scegliete per Diffuse: colore
Rosso=0.01 5, Verde=0, Blu=0.24, e per
Specular: Rosso=0.91 5, Verde=1 ,
Blu=0. Inoltre nella finestra
d'anteprima, scegliete come modello
la scimmia.

Assomiglia all'immagine sotto?

NOTA: La scimmia di Blender di
fatto è uno scimpanzè, di nome
Suzanne. Questo modello 3D, creato
da Willem-Paul van Overbruggen, è
stato introdotto alla comunità di
blender come modello di prova per i

materiali, le texture, le luci, ecc. I
Suzanne Awards (simili agli Oscar
awards) vengono conferiti
annualmente agli artisti blender.
http://en.wikipedia.org/wiki/Suzanne_
Award

Ora, torniamo al nostro pupazzo.
Ricaricate il file pupazzodineve.blend,
selezionate il piano che abbiamo usato
come terreno e date TSM sulla scheda
Material.

Premete New per creare un nuovo
materiale e cambiatene il nome da
“Material” a “Terreno”.

Sotto Diffuse, fate clic col TSM
sulla striscia bianca e inserite i valori
0.5 per il Rosso e il Blu, 0.8 per il Verde.
Sulla finestra Vista 3D, potete vedere
che il colore del terreno passa ad una
superficie verde.

Selezionate un bottone del
pupazzo di neve e premete il pulsante
New nella scheda dei materiali.
Nominatelo “Bottone”, e, sotto
Diffuse, coloratelo di rosso (ora
dovreste sapere in che modo agire,
ma, nel caso non fosse così, ponete
R=1 , V e B=0):

Adesso, premendo il TDM,

selezionate un altro bottone del
pupazzo di neve. Sotto la scheda
materiali, potete osservare il pulsante
New usato in precedenza per creare
un nuovo materiale. Alla sua sinistra
c'è un'icona simile a quella dei
materiali di blender.

Premetela e selezionate
Bottone dalla lista:

http://en.wikipedia.org/wiki/Suzanne_Award
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I materiali che abbiamo creato
sono registrati per usi successivi nel
file blend e molti oggetti differenti
possono condividere lo stesso
materiale.

Tenendo a mente tutto ciò, create i
materiali per le mani, il cappello, il
naso e la pipa. Poi assegnate il
materiale “Bottone” agli altri bottoni
o, se preferite, create un nuovo
materiale per ogni bottone.

Per il cappello ho creato un
materiale con comportamento Halo, in
modo da creare un pupazzo di neve
santo con due aureole!!! Davvero
Santo!

Potete sperimentare anche gli altri
due tipi di comportamenti dei
materiali: Wire e Volume.

Per questo mese, vi raccomando di
scaricare e provare un gioco creato
con blender con il suo motore di gioco
proprietario: Yo frankie!
http://www.yofrankie.org/

Inoltre potete dare un'occhiata a
blenderguru.com, un sito dedicato a
blender, con tanti tutorial per
principianti ed esperti, creato e
mantenuto da Andrew Price, un artista
blender davvero talentuoso.
Divertitevi.
http://www.blenderguru.com

CCOODDEEWWOORRDD

Le soluzioni sono sulla terz'ultima pagina.

Ogni numero nella griglia è il "codice" di una lettere dell'alfabeto.
Quindi il numero "2" può corrispondere alla lettera "L", per
esempio. Tutti, eccetto i codeword difficili , hanno alcune lettere
per iniziare.

I giochi sono copyright, e gentilmente forniti
da, The Puzzle Club - www.thepuzzleclub.com

http://www.yofrankie.org/
http://www.blenderguru.com
http://www.thepuzzleclub.com
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Avere un modello disgustoso non
è qualcosa cui aspirare per le

proprie realizzazioni ovviamente, ma
come mi disse un grande amico
(nonché navigato artista 3D): “Si può
salvare un pessimo modello con delle
buone texture”.

Questo mese proverò a spiegarvi le
basi del texturing (la verità è che io
conosco davvero solo le basi). Ci sono
molti libri che descrivono le tecniche
per applicare le texture, dato che esse
sono una componente cruciale della
modellazione 3D.

Un Lowpoly in computer grafica è
un reticolato solido caratterizzato da
un esiguo numero di poligoni.
Generalmente si usano i modelli low
poly permotivi relativi alle
performance in applicazioni in tempo
reale come i giochi.

I modelli High poly invece sono
solitamente usati per film
d'animazione o immagini in alta
definizione, o in generale in condizioni
in cui non abbiamo restrizioni legate
alla resa in tempo reale
(http://en.wikipedia.org/wiki/Low_pol
y)

Vi faccio vedere un esempio in
modo da farvi capire cosa sono le
texture e di cosa sono capaci.

Nell'immagine sotto abbiamo una
sfera con un piano, illuminati da 3 luci.

Ora invece abbiamo lo stesso
oggetto, ma questa volta con delle
texture e delle mappature con le
immagini per creare la superficie che
ricopre la Terra.

E, ancora, abbiamo lo stesso
oggetto con altre texture.

Infine, una palla di alluminio
gettata come spazzatura su una
spiaggia (cosa molto brutta).

Per l'ultimo modello ho usato
un'immagine per la sabbia e per il
foglio d'alluminio la texture Clouds
con qualche scostamento dalla
normale mappatura.

Ma ora basta con gli esempi.
Carichiamo in nostro file
pupazzodineve.blend.

Selezionate le tre sfere (il corpo)
del nostro pupazzo di neve e premete

Ctrl+J per unire i tre reticolati in un
solo elemento. Rinominatelo “corpo”
nella scheda Object.

Ora andate alla scheda Material e
premete il pulsante Newper creare un
nuovo materiale per il corpo del
nostro pupazzo.

Chiamate il materiale con un nome
univoco, per esempio
“corpo_Materiale”.

http://en.wikipedia.org/wiki/Low_poly
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Quindi premete la scheda
Textures, vicino alla scheda Material.

Fate clic sul pulsante Newper
creare una nuova texture. Chiamatela
“corpo_Texture” o come più vi piace.

Trovate un'immagine della neve da
usare come texture. C'è un gran bel
sito che io uso molto allo scopo
http://www.cgtextures.com. Potete
registrarvi ed avere accesso a migliaia
di immagini da usare come texture
(con la registrazione gratuita potete
scaricare 1 5MB di immagini al mese.
Scaricate quelle a bassa risoluzione,
andranno comunque bene). Per il
nostro pupazzo di neve ho scaricato
l'immagine Snow0041 _5_S.jpg.

Sotto il pulsante Type, selezionate
Image orMovie.

Quindi premete Open sotto la
selezione immagine e navigate fino al
percorso che punta alla vostra
immagine.

Sotto la sezione Mapping

selezionate Sphere alla voce
Projection e lasciate Coordinates così
com'è (su Generated).

Sotto la sezione Influence, mettete
una spunta su Emit e inserite il valore
-0.800 per illuminare un po'
l'immagine; sotto Geometry
selezionate Normal e inserite come
valore 4 per dare la sensazione di una
superficie dura.

Lasciate il resto così com'è o
sperimentate qualche voce per vedere
cosa comporta (ricordate che
sperimentare è una delle tre cose
necessarie per padroneggiare Blender,
le altre due sono “esercitati!”).

Ora, per il terreno, ecco cosa ho
fatto (ovviamente voi potrete usare

un'immagine come alternativa). Ho
creato una texture del tipo Clouds,
aggiustandone alcune impostazioni.

Finite il pupazzo di neve creando e
applicando delle texture al resto dei
reticoli (mani, naso, bocca, ecc...).

Sentitevi liberi di mandarmi le
vostre creazioni del pupazzo di neve
all'indirizzo blender5d@gmail.com, e
mostrerò le migliori qui su Full Circle
Magazine.

Il prossimo mese, vi introdurrò
all'uso del motore di rendering Cycles,
un sistema di rendering veramente
potente, presente in Blender a partire
dalla versione 2.64. Inoltre, inizieremo
un nuovo progetto. Inviatemi le vostre
idee.

Per questo mese, vi faccio vedere
un gioco di nome Dead Cyborg creato
da Endre Barath
(http://www.deadcyborg.com). Un
altro gioco creato con il motore di
gioco di Blender. Divertitevi!

mailto:blender5d@gmail.com
http://www.cgtextures.com
mailto:blender5d@gmail.com
http://www.deadcyborg.com
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Comepredefinito, Blenderutilizza il
suomotore di renderproprietario
chiamatoBlenderRender, ma
personalmente preferisco “Cycles”. È
incluso comeun add-on dalla versione 2.64
(ora siamo alla 2.67) e io lo trovo fantastico
perché, tra le altre cose, si possono
apprezzare i risultati di rendering dei propri
modelli in tempo reale!

Ma andiamoperordine. Trovate in alto
nella finestra di Blender il pulsante a
discesa che riporta la dicitura “Blender
Render””.

Premetelo peraprire ilmenu e
selezionate “CyclesRender”.

Ora sistemiamo la nostra finestra per
avvalerci delmotore di rendering
interattivo cycles.

Nell'angolo in alto a destra della
finestra della vista 3D (finestra principale),

premete il TSMe
trascinate ilmouse per
creare una nuova finestra
3D.

Quindi fate la stessa cosa con la finestra
sinistra che avete ora, ma questa volta
trascinate ilmouse verso il basso percreare
la terza finestra. Dovreste avere qualcosa
simile all'immagine sotto.

Muovete ilmouse sulla finestra in alto a
sinistra, e premete lo 0 del tastierino
numerico per impostare la visuale Camera.

Nella finestra in
basso a sinistra,
invece, premete la
piccola sfera bianca
affianco alpulsante
di modalità oggetto
pervisualizzare il
menu Viewport
Shading.

Dalmenu selezionate “Rendered”.

Ora, ciò che sta succedendo in realtà è
che, in questa finestra, ilmotore di render
di Cycles crea “al volo” un'immagine

fotorealistica del vostromodello. Potete
navigare in questa finestra, potete
ingrandire o rimpicciolire usando la rotella
delmouse oppure + e –del tastierino
numerico, potete traslare la vista tenendo
premuto il stasto Shiftemuovendo il
mouse, ruotare la vista tenendopremuto il
tasto centrale delmousementre lo si
muove e, in generale, fare qualsiasi
movimento della vista che abbiamo
esaminato nella prima parte di questi
articoli (FCM#68).

È ilmomentobuonopersalvare la
vostra configurazione di finestre. Sulla
barra d'intestazione Info (quella che
normalmente è in alto nella finestra),
focalizzate l'attenzione sulpulsante della
visuale che reca la scritta “Default”
(chiamato così in maniera un po' stupida,
dato che ci sono un belpo' di configurazioni

chiamateDefault in Blender).

Facendo clic sulla piccola icona sulla
sinistra (il quadratino rosso), potete fare
una selezione da una lista di configurazioni
predefinite. Premete il pulsante + affianco
a Default. Apparirà il valore “Default.001 ”.
Rinominatelo con un nome che lo



full circle magazine n.73 25 indice ^

Nicholas vive e lavora in Grecia.
Lavora per una casa di post-
produzione (pubblicità-film) da diversi
anni; è migrato su Ubuntu perché
“renderizza più velocemente”. Potete
mandargli una mail all' indirizzo
blender5d@gmail.com

HOWTO - BLENDER Pt 6a
contraddistingua, tipo “Modello” per
indicare che lo utilizzerete quando farete la
modellazione d'oggetti. Quindi salvate il
vostro file con un nomeunivoco; io ho
chiamato ilmio “Figure_base.blend”. La
prossima volta che aprirete questo file, la
configurazione “Modello” verrà aperta in
automatico.

SUGGERIMENTO: Se fate partire un
nuovoprogetto, o ne caricate uno vecchio,
la vostra configurazione personalizzata
NON sarà presente. Ci sarà solo quella
predefinita di Blender. Peravere la vostra
configurazione personalizzata disponibile
ogni qualvolta iniziate un nuovoprogetto,
dovete salvarla come file d'avvio premendo
Ctrl-U. Notate che se sovrascrivete il file
d'avvio premendoCtrl-U, QUALSIASI cosa
avete cambiato verrà salvata alla stessa
stregua. Peresempio se eliminate il cubo e
sovrascrivete il file d'avvio, la prossima volta
il cubo non sarà là! Ovviamente potete
sempre tornare alla configurazione d'avvio
originale (File > Load FactorySettings).

Muovete il vostromouse sulla finestra
Vista 3D, e premete sul tastierino numerico
5 e poi 1 peravere
una vista
ortogonale
frontale.
Trascinate la
freccia blu del
cubo giusto un
pelino sopra il

cursore, come illustrato.

Premete Shift-Se selezionateCursorto
Centerse già non lo fosse, oppure Premete
Ctrl-C. Ora aggiungete un piano e scalatelo
di un fattore 10 (dovreste sapere come si
fa). Create anche un Conoe una UVSphere.
Selezionate perognuna lo smooth e
muovetele inmododa avere una buona
vista nella finestra 3DView in alto a sinistra
(quella con la visuale Camera).

Dovrebbe venir fuori qualcosa simile
all'immagine sotto.

Selezionate il piano e premete la
schedaMaterial sulla destra, sotto la
finestra proprietà (comemostrato in alto a
destra).

Un nuovo setdi parametri da impostare
a differenza delBlenderRender! Premete il
pulsanteNew(come fatto per ilBlender
Render) peraggiungere un nuovo
materiale. Chiamatelo “Terreno”. Sotto
Surface, vedrete il valore predefinito che è

“DiffuseBSDF”. È come ilDiffuse che
abbiamousato in FCM#72 perdipingere i
nostri oggetti. Premetelo e dalmenu
selezionate “Glossy”.

Quasi istantaneamente (dipende dalla
potenza della propria CPU) potrete vedere
nella finestra delRendering 3D cosa avete
realizzato. Impressionante, in così pochi clic!
Ora, se vi piace, premete il pulsante colore
e assegnate un colore per la vostra
superficie lucida comeuno specchio. Io ho
scelto il viola (R:0.5, G:0.4, B:0.8). Appena
cambiate il colore, Cycle comincia a
renderizzare il risultato. Avrete
un'anteprima inmanieramolto rapida.

Ora selezionate il cubo, aggiungete un
nuovomateriale e impostate il tipo di

superficie su AnisotropicBSDFper
conferirgli un aspettometallizzato.
Probabilmente la tipologia di materiale che
io preferisco.

Qui sopra c'è tutto quello che abbiamo
realizzato.

Più info su questo argomento ilmese
prossimo...

mailto:blender5d@gmail.com
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Lo scorso mese abbiamo usato
Cycles Render per creare

l'immagine riportata in basso a sinistra.

Ora creiamo un'immagine simile (in
basso a destra) con il motore di
rendering di Blender.

La prima cosa che possiamo notare
(almeno perme) sono le ombre. Le
ombre che la nostra sorgente di luce
Point proietta, con il motore di Blender,
sono quasi nere. Questo fenomeno si
verifica perché nelmotore di rendering
di Blender la luce viene emessa solo
dalla lampada. Questo non è
verosimile, dato che nelmondo reale

tutti gli oggetti emettono o riflettono
la luce.

D'altro canto, il motore di rendering
Cycles calcola la luce che ogni oggetto
riceve da quelli che lo circondano.
Potete osservare il cono e notare come
l'ombra dal cubo si affievolisce con
facilità (contrariamente a quella del
cono ottenuta con Blender Renderer),
e abbiamo una superficie d'appoggio
riflettente e un cubo di metallo
brillante nella nostra scena.

Un altro aspetto assolutamente

cruciale, nonché una delle differenze
principali tra Blender e Cycles, è
squisitamente tecnico.

Andate su File > User Preference >
System (immagine sopra).

Nell'angolo in basso a destra della
scheda System potete indicare se il
vostro computer supporta Nvidia

CUDAalla voce ComputerDevice.

La mia GPU ha il supporto per
CUDA, quindi posso abilitarlo. Potete
verificarlo anche al link ufficiale di
supporto di CUDA:
https://developer.nvidia.com/cuda-
gpus

Se siete abbastanza fortunati da
avere una scheda Nvidia CUDA, potete
abilitarla alla voce Compute Device che
ho menzionato in precedenza E nel
pannello delle proprietà, alla scheda
Render->Device->GPU Compute per

https://developer.nvidia.com/cuda-gpus
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avere tutta la potenza necessaria per i
vostri rendering.

Cycles può usare i processori della
GPU CUDAper renderizzare, il che è
molto più veloce della CPU.
Informazioni riguardo CUDA sono su
wikipedia:
http://it.wikipedia.org/wiki/CUDA

Se non avete una GPU CUDA,
potete usare il linguaggio Open
Shading, ma è un tantino pieno di bug e
non vi posso raccomandare questo
metodo di renderizzazione, almeno per
il momento. Nel prossimo futuro però
ho la sensazione che sarà ancora più
veloce della procedura di rendering di
CUDA.

Ma ora è troppo con le informazioni

tecniche.

Guardiamo un'altra interessante
funzionalità di Cycles. Aprite il file
.blend che abbiamo cominciato lo
scorso mese, o createne uno nuovo.
Non dimenticate di selezionare in alto
Cycles Render.

Inoltre selezionate nella finestra 3D

view 'Rendered' per visualizzarne il
risultato.

Selezionate la sfera, navigate nel

Pannello Properties e cambiate
l'ombreggiatore Surface dal consueto
Diffuse BSDF in Emission.

Potete osservare nella finestra
Preview il bell'effetto che abbiamo
creato. Potete aggiustare i moduli
Color e Strength per la luce che il
nostro oggetto emette. Inoltre per
tutti gli ombreggiatori potete
aggiustare molti altri parametri (come
la texture, ad esempio) premendo il
piccolo punto alla destra dei valori di
Color e Strength.

Selezionate il nostro cubo
dall'aspetto metallico, premete il
piccolo punto affianco a Color, e
cambiatene la texture in Brick Texture.
Osservate quindi il risultato nella vostra

http://en.wikipedia.org/wiki/CUDA
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finestra 3D View e selezionate diverse
texture finché non trovate qualcosa
che vi aggradi.

SUGGERIMENTO: I piccoli punti
sono presenti in tutti gli
ombreggiatori, non solo in
Emission, e personalmente li trovo
molto utili per creare velocemente
cose interessanti.

Un altro ombreggiatore notevole è
Mix Shader. Come si può facilmente
intuire dal suo nome, è un
ombreggiatore che potete usare per
mixare gli altri ombreggiatori. Due altri
ombreggiatori, per essere precisi.
Quindi, selezioniamo il nostro cono e
cambiamone l'ombreggiatore da
Diffuse BSDF in Mix Shader.
Applichiamo quindi un Glass Shader e
un Diffuse shader oppure un Glossy
Shader e un Anisotropic Shader al cono.
Cambiate il valore del parametro Fac
per aggiustare la percentuale del
secondo ombreggiatore (0.000 vuol
dire 0% e 1 .000 corrisponde al 1 00%).

Guardate il risultato nella finestra
Preview e aggiustate quindi le
impostazioni come preferite.

Un'altra cosa che vorrei menzionare
in questa piccola deliziosa introduzione
sul Cycles Renderer, è l'uso dei piani
anziché delle luci.

Molte persone che lavorano in
Blender e Cycles, usano dei piani per
illuminare le proprie scene. Sembra
un'illuminazione “più realistica”, e io
non ho alcuna ragione per contraddirli.

Nell'immagine sotto potete vedere
cosa ho realizzato io.

Per questo mese, seguite questo
link http://vimeo.com/6801 0380 per
godere di un bellissimo lavoro di tre

persone e Blender (le congratulazioni
vanno fatte a Javier Trapiella, Baol
Bardot Bulsara e Robert Green).

Inoltre, visitate il sito
www.blendernews.org per entrare e
condividere esperienze con migliaia di
artisti professionisti!

http://blendernews.org/xe/?mid=F
eature_Articles&document_srl=1 27
4

mailto:blender5d@gmail.com
http://vimeo.com/68010380
http://blendernews.org/xe/?mid=Feature_Articles&document_srl=1274
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D opo un mese di pausa, siamo di
nuovo qui per esplorare i

modificatori. Uno dei miei preferiti è
Subdivision Surface!

Suggerimento: I modificatori sono
operazioni automatiche che lavorano
sull'aspetto di un oggetto e sul suo
rendering, ma non nemodificano
l'effettiva geometria.

Subdivision Surface (abbreviato in
Subsurf) è un metodo per suddividere le
facce di un reticolo in modo da
conferirgli un aspetto più levigato,
utilizzato permodellare superfici lisce
complesse con dei reticoli semplici e
con pochi vertici (sorgente:
wiki.blender.org).

Aprite un nuovo progetto in Blender
e selezionate (se non è già fatto) il cubo.

Ora, diamo un'occhiata alla scheda
modificatori (illustrata in basso) nella
finestra proprietà.

Focalizzate l'attenzione su una
piccola chiave inglese. È questo il

simbolo dei modificatori in Blender.

Premete con il tasto sinistro del
mouse l'icona della chiave e quindi il
pulsante “Add modifier”.

Si aprirà una grande finestra con
tutti i modificatori presenti in Blender.
Perora ci concentreremo su Subdivision
Surface (Subsurfda ora in avanti).
Trovate la voce (evidenziata nella figura
qui sopra) e selezionatela per
aggiungere tale modificatore al cubo.

Il vostro cubo si trasformerà in un
prisma a 24 facce! Ma se renderizzate
l'immagine, potete vedere un oggetto a
96 facce... Strano! Vediamo perché

avviene tutto questo.

Quando aggiungete ilmodificatore
Subsurfal vostro cubo, questi suddivide
in maniera predefinita le facce del cubo
(6) per4, conferendogli un nuovo
aspetto a 24 facce. Potete controllare
quante volte suddividere le facce dei
vostri oggetti nella sezione Subdivision
comemostrato affianco. La scritta
“View:1 ” indica che state suddividendo
l'oggetto un'unica volta.

Nella scheda Subdivision vi è un
altro pulsante di controllo per
modificare le suddivisioni in fase di
rendering dell'immagine (Render:2).
Ecco perché nella 3D viewavete una
figura a 24 facce (suddivisa un'unica
volta), mentre, quando ne fate il
rendering, avete una figura a 6x4x4=96

facce (suddivisa 2 volte). Premete la
freccetta a destra per incrementare la
ViewSubdivision in 2. Ora quello che
vedete è quello di cui fate il rendering.

Ora aumentate le suddivisioni View
e Renderdi uno. Per cui sotto
Subdivisions dovreste avere 3
suddivisioni per la vista e per il render:

Sulla sinistra della finestra con la
vista 3D, sotto Object Tools (premere T
permostrare/nascondere), premete
smooth per lisciare l'aspetto del cubo.
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Il vostro “cubo” dovrebbe

assomigliare a qualcosa tipo questo:

Il segreto della potenza di Subsurfsi
rivela quando premete il tasto TAB per
entrare in modalità modifica. Potete

vedere la sfera che abbiamo creato con
Subsurfe la relativa figura di partenza,
ossia il cubo. Non potetemodificare la
sfera (ricordate che il vostro effettivo
oggetto è il cubo), ma potete
modificare il cubo.

Selezionate la faccia alta del cubo e
premete il tasto E perestruderla,
confermando tale estrusione con il
tasto Invio. Scalatela del 50% premendo
il tasto S e 0.5.

Muovete la faccia estrusa di due
unità verso il basso (premete G, quindi Z
per limitare ilmovimento al solo asse Z
e premete -2 permuoverlo in basso).

Avete creato una tazza riccamente
dettagliata!

Modificando il cubo, si modifica
dinamicamente anche la sfera in
maniera organica. Senza Subsurf
servirebbero un sacco di tempo e di
sforzi per creare questa tazza.

Un altro strumento critico che si può
usare con Subsurfè Loop Cut.

Suggerimento: Loop Cuto Loop
Subdivide (scorciatoia Ctrl-R) effettua
un taglio delle facce inserendo un
nuovo anello di spigoli che interseca il
lato prescelto (fonte: wiki.blender.org)

Deselezionate tutto premendo il
tasto Ae poi Ctrl-R. Passate ilmouse
sopra le facce del cubo e noterete una
nuova poligonale viola “tagliare” i lati,
comemostrato nella figura sotto:

Premete 2 omuovete la rotellina del
mouse per aggiungere 2 tagli ad anello.
Premete Invio per confermare.

Fatto ciò, vi troverete 2 poligonali
gialle selezionate che potrete traslare
liberamentemuovendo ilmouse.
Premete il tasto destro delmouse per
piazzarle al centro del lato prescelto (in

posizione predefinita).

Premete Aperdeselezionare tutto.

Ora, per selezionare uno dei due lati
tagliati, abbiamo bisogno di usare la
combinazione Shift-Alt-tasto destro del
mouse.

Suggerimento: La vera combinazione
per selezionare la poligonale di taglio è
Alt-tasto destro delmouse, ma sotto
Linux questa va in conflitto con le
funzioni assegnate dal sistema al tasto
Alt.

Con l'anello di taglio più a sinistra
selezionato, premete Ctrl-E per aprire il
menu speciale per gli spigoli e
selezionate Edge Slide comemostrato
in figura nella prossima pagina.
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Potete spostare l'anellomuovendo
ilmouse o digitando direttamente il
valore dello spostamento (a esempio
-0.8). Deselezionate tutto premendo il
tasto Ae selezionate l'altro taglio.
Muovetelo di 0.8 unità.

Create un altro duplice taglio
sull'altro lato del cubo (guardate
l'immagine in alto a destra).

Selezionate e deselezionate
qualsiasi cosa desiderate. Muovete un
singolo vertice emuovetelo un po' per
vedere cosa succede al vostro oggetto.

Selezionate due vertici e scalateli
riducendone o aumentandone la
distanza. Mentre siete in EditMode,
aggiungete una nuova figura, a esempio
un piano, e notate cosa vien fuori.

Il prossimomese continueremo il
nostro viaggio con Subsurf, provando a
creare qualcosa. Per favoremandatemi
suggerimenti o domande all'indirizzo:
blender5@gmail.com

EDIZIONI SPECIALI DI LIBREOFFICE:

http://fullcirclemagazine.org/libreoffice-
special-edition-volume-one/

http://fullcirclemagazine.org/libreoffice-
special-edition-volume-two/

EDIZIONI SPECIALI DI INKSCAPE:

http://fullcirclemagazine.org/inkscape-
special-edition-volume-one/

http://fullcirclemagazine.org/inkscape-
special-edition-volume-two/

mailto:blender5d@gmail.com
mailto:blender5d@gmail.com
http://fullcirclemagazine.org/libreoffice-special-edition-volume-one/
http://fullcirclemagazine.org/libreoffice-special-edition-volume-two/
http://fullcirclemagazine.org/inkscape-special-edition-volume-one/
http://fullcirclemagazine.org/inkscape-special-edition-volume-two/


full circle magazine #77 1 5 indice ^

HH OOWW--TTOO
Scritto da Nicholas Kopakakis BBlleenn dd eerr:: PPaa rrttee 88

L o scorso mese abbiamo
introdotto il modificatore SubSurf

(Subdivision Surface), uno strumento
molto utile per creare modelli levigati
e di alta qualità. Bisogna fare molta
pratica per familiarizzare con questo
strumento e rivelarne le potenzialità.
Vediamo qualche esempio.

CREARE UN UOVO

Aprite un nuovo progetto in
Blender e aggiungetevi un cubo (se
non dovesse già esserci).

Con il mouse nella finestra Vista
3D, premete il tasto TAB per passare
alla modalità Edit. Premete A per
deselezionare tutti i vertici ed
evidenziate solo i quattro vertici
superiori.

Premete il tasto S e digitate 0.5
per scalare la faccia selezionata del
50%. Quindi tocca al tasto G (G di
Grab) e al valore 0.1 per muovere la
faccia selezionata verso l'alto.
Abbiamo qualcosa di simile ad una
piramide Maya. Premete il tasto TAB
per uscire dalla modalità Edit e ritornare
alla modalità oggetto.

È questo il potere di Subsurf: da una
piramide possiamo ricavare un uovo!
Andate ora nel pannello delle proprietà
sulla destra e selezionate la scheda
modificatori che ha per icona una chiave
inglese per accedere al modificatore
SubSurf. Aggiungete il modificatore, e
incrementate i valori di View e Render a
3. Sulla sinistra, sotto la scheda Object

Tools, applicate l'ombreggiatore
Smooth. Ecco l'uovo.

Suggerimento: il “metodo non
distruttivo” è qualcosa che potete
cogliere utilizzando i modificatori.
Potete creare un oggetto usando un
modificatore, ma qualora decideste di
non usare più tale modificatore, è
molto semplice eliminarlo o
modificarlo. In effetti il modello di
partenza giace lì, “sotto” le vostre
modifiche. Quando però premete il
tasto Apply nella scheda modificatore,
“distruggete” questa funzionalità.

OK. Abbiamo conosciuto SubSurf in
modalità non distruttiva. Ora possiamo
vedere che tipo di reticolo possiamo
creare effettivamente applicando il
nostro modificatore ai modelli.

CREARE UN PROIETTILE

A dire il vero, non sono un grande
fan di armi e proiettili. Ma, nel
momento in cui modellate un oggetto,
avete bisogno di sapere a cosa
assomiglia. Grazie a Dio esistono
Google e un sacco di banche di
immagini per questo scopo. Per cui,
dopo pochi clic, ho trovato un
immagine di proiettile su cui lavorare
(nel prossimo articolo vi mostrerò
come usare le immagini come
cianografia permodellare gli oggetti).

Cominciamo un nuovo progetto con
un cubo all'interno. Sul cubo,
aggiungete il modificatore SubSurf e
portate a 3 sia View che Render.
Premete S per scalare il cubo, Z per
riferire la procedura all'asse Z e 1 .5 per
scalare. Premere poi il tasto TAB per
entrare in modalità Edit. Selezionate i
quattro vertici superiori e premete il
tasto E per estrudere. La dimensione 1
dovrebbe andar bene. Dovreste avere
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qualcosa di simile all'immagine sotto.

Premete Ctrl + R. Dopo aver
premuto il TSM per accettare il taglio
ad anello, muovetelo verso il basso,
verso la base del vostro modello.
Notate che l'oggetto modificato
cambia la propria forma. Adesso
possiamo accettare la modifica
premendo Apply nella scheda dei
modificatori.

Tornate nella modalità Edit per
vedere cos'è successo. Abbiamo un
reticolo creato dal modificatore
SubSurf!

Premete Alt-Ctrl-R per selezionare
una serie di superfici disposte ad anello.

Premete E e poi Invio per
confermare l'estrusione. Digitate S
per scalare la vostra selezione

davvero di pochissimo. Pigiate G per
muovere la selezione in basso, verso
il centro del proiettile. Scalatela un
po' per creare qualcosa di simile
all'immagine sotto.

OK. Abbiamo una forma di
proiettile elementare. Aggiustate
qualsiasi cosa desiderate, iniziate un
nuovo progetto e create un razzo o

qualcos'altro usando il modificatore
SubSurf. Quando sarete felici delle
vostre figure modificate, applicate il
modificatore e ultimate il vostro
progetto. Ricordate che quando
applicate un modificatore avete un
nuovo reticolo, per cui potrete ri-
applicare nuovamente il modificatore
che vi pare. Più avanti parleremo del
blocco dei modificatori e di come
funziona.

Il mese prossimo, introdurremo le
curve di Bezier e modellerò il logo
della mia squadra preferita.

Per questo mese, posso suggerire
la comunità blendswap.com. Artisti
3D da qualsiasi parte del mondo
possono postare i loro lavori con
blender e avere opportunità di lavoro
concrete!

mailto:blender5d@gmail.com
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C ome vi avevo promesso, questo
mese introdurremo le Curve di

Bezier.

Le Curve di Bezier (chiamate così
in onore dell'ingegnere francese
Pierre Bezier) sono usate nella
computer grafica per impostare le
coordinate di una curva uniforme in
maniera molto semplice.

Vediamo di cosa stiamo parlando.
Iniziamo un nuovo progetto in
Blender e sbarazziamoci del cubo
(selezionare il cubo, premere X per
eliminare e confermare).

Adesso premiamo Ctrl-A per avere
il menù Add --> Curve --> Bezier.

Premere R per ruotare, X per
selezionare l'asse X e 90 per l'angolo
di rotazione. Quindi premiamo sul
Tastierino Numerico 1 per la vista
frontale e 5 per la vista ortogonale.

Dovremmo ottenere qualcosa di
simile all'immagine sotto:

Premiamo il tasto TAB per entrare
in modalità Edit. Potete osservare
una figura piuttosto strana, che
somiglia a una spina di pesce o a una
serie di frecce direzionali, comunque
vogliate chiamarla.

Le cose interessanti sono le due

linee rosa che rappresentano gli
spigoli della figura (tale “figura” è il
vero e proprio segmento della curva).
Concentriamoci sulla linea rosa a
destra. Premiamo il tasto A per
deselezionare tutto.

Selezioniamo il vertice al centro
(chiamato punto di controllo) come
mostrato sotto:

Notate che gli altri due vertici
(detti maniglie) vengono selezionati
automaticamente. Premere il tasto G
per muovere il punto di controllo. Il
lato destro della curva si muoverà.
Premere il TDM (tasto destro del
mouse) per cancellare o il TSM (tasto
sinistro del mouse) per confermare il
movimento. Ora, selezioniamo il
vertice più a destra (che per il
momento coincide con la maniglia).
Muoviamolo come fatto in
precedenza col punto di controllo.

Il punto di controllo rimarrà in
posizione, mentre le maniglie si
sposteranno. Inoltre, la curvatura
della curva si modifica! Anche
muovendo le altre maniglie la curva
cambia. Muovendo le maniglie verso
il punto di controllo cambia la

concavità delle rispettive curve.

Con il punto di controllo destro
selezionato, premiamo CTRL+TSM.
Stiamo creando un altro punto di
controllo e modificando a tutti gli
effetti la curva. Il punto di controllo
appena creato è ora l'ultimo e
l'ultimo rappresenta il punto in cui la
curva finisce. Se vogliamo estendere
la curva dal lato di partenza,
selezioniamo il lato iniziale e
premiamo CTRL+TSM per aggiungere
un nuovo punto di controllo come
spigolo di partenza. Se vogliamo
chiudere la curva, selezioniamo i due
spigoli e premiamo F per aggiungervi
un segmento che li chiuda. Questo è
tutto quello di cui abbiamo bisogno
per creare il nostro Logo con le curve
di Bezier.

Per maggiori dettagli sulle curve
di Bezier andate su
http://wiki.blender.org/index.php/Do
c:2.6/Manual/Modeling/Curves

Il nostro obiettivo è creare un logo
tridimensionale partendo da
un'immagine bidimensionale;
cominceremo da qualcosa di
semplice. La mia squadra del cuore in

http://wiki.blender.org/index.php/Doc:2.6/Manual/Modeling/Curves
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HOWTO - BLENDER: PARTE 9a
Grecia è il Panathinaikos, quindi
cerchiamo su Google il logo del club.

Ho trovato un logo che fa
assolutamente al caso nostro.

Non mi interessa particolarmente
la scritta, per cui volendo si potrebbe
rimuovere con Gimp. Ma va bene per
le mie intenzioni, quindi la lascerò
così com'è. La cosa buona è che
dobbiamo modellare solo un trifoglio.
Compito semplice per una curva di
Bezier.

Quindi, cominciamo un nuovo
progetto, rimuoviamo il cubo e
posizioniamoci in una vista
Ortogonale frontale nella finestra 3D
View.

Uno strumento potente che ci
conferisce Blender è la possibilità di
usare un'immagine come piantina
sullo sfondo per semplificare la

modellazione.

Premiamo il tasto N per
visualizzare/nascondere il pannello
sulla destra della finestra 3D View
(pannello Properties). Rendiamolo
visibile, scorriamo verso il basso e
spuntiamo l'opzione Background
Images.

Premiamo il tasto Open e
navighiamo verso la cartella in cui
abbiamo scaricato l'immagine.
Selezioniamola e apriamola.

L'immagine apparirà sullo sfondo.
Dal pannello che appare proprio sotto
al pulsante Open usato prima,
possiamo alterare alcune sue
proprietà (la trasparenza o la
posizione, ad esempio).

Suggerimento: Le immagini sullo

sfondo sono visibili solo con la vista
Ortogonale e con precise angolazioni
(frontale, da sinistra, da destra,
dall'alto, ecc.). In seguito, vi mostrerò
le tecniche per manipolare le
immagini come oggetti 3D visibili da
ogni angolo e ogni direzione.

Ora aggiungiamo una Curva -->
Bezier. Premiamo il tasto TAB per
andare in modalità Edit e usiamo
CTRL+TSM per aggiungere i punti di
controllo necessari. Creiamo una linea
che copra il perimetro del trifoglio
come illustrato in basso. Usiamo i
manipolatori per creare le curve di cui
abbiamo bisogno:

Fatto ciò, non avremo più bisogno
dell'immagine sullo sfondo.
Deselezioniamo l'opzione
corrispondente sul pannello proprietà
o premiamo la X subito sotto a destra
del pulsante Add.

A questo punto, abbiamo una
figura bidimensionale e avremo un
po' di lavoro da fare per renderla
tridimensionale.

Continua...

mailto:blender5d@gmail.com
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L o scorso mese abbiamo creato un
trifoglio usando le curve di Bezier,

oltre a usare un'immagine di sfondo
permodellarlo. Adesso è tempo di
aggiungere la terza dimensione al
nostro modello.

Sulla destra, sotto la finestra
Properties, selezionate la scheda
Curve:

Scorrete in basso e troverete il
pannello Geometry. Inserite il valore
0.2 in Extrude, come mostrato
nell'immagine qui sotto:

Potete controllare nella finestra 3D
View che la vostra immagine comincia
ad avere una profondità.

Ora, una cosa molto interessante si
trova nel pannello Shape della finestra
Properties:

Potete vedere che il pulsante 3D è
selezionato. Premete 2D. Alla voce Fill,
selezionate Back. Il vostro modello sarà
'riempito' nella parte posteriore. Adesso
selezionate Front. Come ci si poteva
aspettare, il modello viene 'riempito'

nella parte frontale. E come potete
immaginare, se doveste selezionare
None, nulla verrà 'riempito'.
Selezioniamo Both.

Avete quindi ora un modello solido in
3D, come si evince dalla finestra 3D
View.

Modifichiamo qualcosa. Nel pannello
Geometry, menzionato in precedenza,
c'è il parametro Bevel. In Depth, inserite
il valore 0.03, e in Resolution il valore 2.
Potete alterare il valore di Depth se
desiderate smussare più o meno gli
spigoli del vostro modello. Perme 0.03
va bene.

Adesso è il momento di aggiungere i
materiali al nostro modello. Date

un'occhiata alle precedenti uscite di Full
Circle Magazine se non ricordate come
farlo. Il mio materiale preferito è il vetro,
per cui ho creato un vetro verde per il
mio trifoglio. Inoltre, aggiungete un
piano bianco come sfondo per avere una
migliore resa visiva.

Il mese prossimo introdurremo il
Testo. Aggiungeremo del testo alla
nostra immagine creata in questa
edizione, ma esamineremo anche una
tecnica per realizzare cose interessanti
con i nostri modelli utilizzando un
modificatore davvero eccezionale.
Rimanete sintonizzati!

Il 3 Novembre, www.blender.org ha
cambiato il proprio look. Per cui, non ho
da suggerire nessun altro sito.
Esplorate il nuovo e divertitevi!

http://www.blender.org
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Q uestomese ci divertiremo un po'
con i testi in Blender. Per cui, avviate

Blendered eliminate il cubo predefinito
(selezionate il cubo, premete Xe
confermate l'eliminazione). Adesso,
premete il tasto Aper aggiungere un
nuovo oggetto nella vostra scena.
Aggiungete il testo (guardate
l'immagine sotto).

La prima cosa che noterete è che, per
qualchemotivo, blender aggiunge gli
oggetti di testo dinanzi alla vista dall'alto.
Io preferisco porlo davanti alla vista
frontale, per cui ruotiamo il nostro testo
di 90 gradi sull'asse X (Premete il tasto R,
poi il tasto Xe digitate 90).

Ora, usando il tastierino numerico
premete 1 per la vista frontale e 5 per la
vista ortogonale. Dovreste avere
qualcosa come l'immagine in basso.

Ora che abbiamo un aspettomigliore
per il nostro testo, cambiamolo. Premete
il tasto TAB perentrare in modalità
modifica. Cambiate il predefinito “Text”
in “Full CircleMagazine”. Uscite dalla
modalità modifica premendo
nuovamente il tasto TAB. Grande!

Tutto sommato, però, abbiamo un
testo veramente noioso (sebbene dica
“Full CircleMagazine”). Con l'oggetto di
testo selezionato, esaminiamo la finestra
Properties. Selezionate la scheda che ha
per icona una F per rivelare alcuni
dettagli interessanti sul nostro oggetto.

Prima di tutto, cambiate il nome del
nostro oggetto dal solito “Text” in
“FCM”. Quindi cambiate il valore
extrude, alla voce Geometry, in 0.2. Non
vedrete alcuna differenza con il vostro
testo. Ma, se ruotate la vista (tenendo
premuto il pulsante centrale delmouse e
muovendo quest'ultimo, oppure
premendo il tasti 2,4,6 e 8 sul tastierino
numerico) potete vedere che abbiamo
estruso il nostro testo. Fantastico!

Possiamo anche aggiustare
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HOWTO - BLENDER Parte 1 0a
l'ammontare del fattore bevel.

Cambiate il valore di Depth in 0.05 e
Resolution in 1 0.

Ok. Adesso cambiamo il valore di
Font.

Premete l'icona file (ossia quella tra la
F e la X) e navigate nella vostra cartella
Font. Selezionate il Font dei vostri
desideri. Io ho scelto Isabella (cercate nei
repositories il pacchetto ubuntustudio-
font-meta). I valori inseriti
precedentemente in Geometry non
vanno bene con questo font. Imposto
quindi Extrude=0.05 e Bevel=0.02.

Ok, adesso aggiungete una scatola e
ruotatela, scalatela, muovetela. Usate
anche le textures! Sarà facile creare
un'immagine come quella qui sotto.

Continua...

mailto:blender5d@gmail.com
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Lo scorsomese abbiamo creato un
oggetto Testo e lo abbiamo

manipolato (rotazione, scala, ecc...). Ora
vediamoqualche altra miglioria che
Blenderci permette di applicare.

Sulla destra, sotto la scheda F,
abbiamo tutti gli ottimi strumenti per
modificare il fontdelnostro oggetto, che
come ricorderete abbiamovisto lo scorso
mese. Rimarremo su quelli basilari perora,
sebbeneBlenderforniscamolte
personalizzazioni. Quindi, alla voce Font,
troviamoSize e Shear. Potrete rendere il
testo più grande opiù piccolomodificando
il valore di Size, così comepotrete inclinare
il testo verso sinistra o destra dando a
Shearrispettivamente un valore negativo
o positivo.

Inoltre, alla voce Shape, potrete
modificare la risoluzione dell'oggetto
Testo o il suo riempimento (Fill). Fate dei
testcon questi valori e capiretemeglio di
quanto io non possa spiegarvi.

Ora, diamo il via ad un nuovoprogetto
peresaminare qualcos'altro (vi spiegherò
dopo il perché abbiamo la necessità di
iniziare un nuovoprogetto perquesto
esempio). Non eliminate il cubo,
spostatelo giusto un pochino e
aggiungete un nuovooggetto Testo
premendo Shift+A! Texto dalmenu che si
apre facendo clic su Add (questo lo sapete
da ora!). Ruotate l'oggetto Testo perporlo
davanti al cubo nella vista frontale, ed
aumentate il valore di estrusione nella
scheda Fa 0,5.Muovete i vostri oggetti
(testo e cubo) finché non avrete qualcosa
simile all'immagine in basso:

Per il nostro esempio è fondamentale
che i due oggetti si intersechino.

È tempodi vedere qualcosa di
interessante. Con l'oggetto selezionato,
premeteAlt-C. Dalmenu che si apre,
selezionateMesh from
Curve/Meta/Surf/Text.

Si è verificata una cosamolto
interessante. Blenderha creato un
oggetto reticolato che può essere
manipolato comequalsiasi altro oggetto.
Premete il tasto TABperentrare in
modalità Edit, e scoprite da soli di cosa sto

parlando.

Ilmotivo per il quale ho voluto
convertire il testo in un oggetto reticolato
è presto detto: usare i modificatori chemi
piacciono tanto e che invito a
sperimentare, come ilmodificatore
Boolean. Quindi selezionate il cubo e
aprite la scheda dei modificatori.

Aggiungete un nuovomodificatore
chiamatoBoolean.
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Sotto la scheda Operation selezionate
Difference e in Object selezionate
l'oggetto creato a partire dal testo (non lo
abbiamo rinominato, percui si chiamerà
“Text”). Quindi premeteApply.

Dopo qualche tempo, dipende dalla
potenza e dalla memoria del vostro
computer, verrà completata l'operazione
Boolean. Percui, semuovete il testo o il
cubopotrete vedere cosa avete
combinato.

Blenderha calcolato la differenza tra i
due oggetti e l'ha ritagliata dall'oggetto al
quale abbiamo applicato ilmodificatore.

Se avessimoprovato con oggetti più
complessi, come il testo “FullCircle
Magazine” (con un fontelegante e tutte le
curve che avevamo applicato), Blender
sarebbe andato in crash. Ecco perché
abbiamousato un oggetto di testo
semplice. Anche il comandoConvert-to-
mesh sarebbe stato più esoso in termini di
richieste perpoteressere gestito da

Blender.

Ilmodificatore Boolean è comunque
molto utile e leggero qualora si abbiano
oggetti semplici come cubi o piramidi,
giusto perfare un esempio.

Perquestomese, vi suggerisco il sito
http://gooseberry.blender.org/. È un
nuovoprogetto, appena avviato
dall'IstitutoBlender.

Il prossimomese, continueremo con il
testo introducendo un po' più di
movimento, omeglio un'animazione.
Proveremo con qualcosa di simile
all'introduzione di StarWars: “Molto
tempo fa, in una galassia molto, molto

lontana...”

Divertitevi!

mailto:blender5d@gmail.com
http://gooseberry.blender.org/

